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Package contents
• 1 x ProfiShark 10G main unit
• 1 x USB key containing drivers,
software and manual
• 1 x USB 3.0 cable

For any questions, technical or otherwise,
contact our customer support
through our website:

or by email:

For the latest documentation and software,
visit our Resource Center:
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General Information

The ProfiShark 10G is a portable fiber optic TAP and
troubleshooter, and provides visibility into 10G fiber optic
networks. It accepts two SFP+ modules (SR, LR, ER), and sends
the incoming traffic to a USB 3.0 output.
The ProfiShark 10G can be set to either SPAN or In-Line mode.
SPAN mode receives traffic from any connected SFP+ modules,
while In-Line mode receives and transmits traffic between both
ports.
The ProfiShark 10G captures packets of all sizes and types,
and provides real time traffic statistics, SFP+ module and fiber
information, and various traffic capture settings and options. It
also incorporates hardware filters, deep packet inspection, and
packet slicing.

Features
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- 10G fiber monitoring on USB 3.0
- USB 3.0 powered, no adapter required
- Hardware aggregation
- SPAN and In-Line modes
- Capture any type of frames
- Hardware filtering, deep packet inspection
- Packet slicing (adjustable packet size)
- 8 ns hardware timestamping for accurate latency testing
- Customizable real time statistics
- In-depth network port diagnostic
- Low level error and bandwidth monitoring
- Direct capture to disk
- Invisible to the network
- Lightweight and portable
- Quick setup and easy to use

ProfiShark 10G Visual Description

1 - Port A (SFP+) connected to the network
2 - Port B (SFP+) connected to the network
3 - Power indicator LED
4 - USB 3.0 connector linked to your monitoring device
(i.e. a laptop computer)
5 - Optional DC input (5V/1A)
6 – 7 – 8 – 9 – The SFP+ or network status is displayed on the
front LEDs.
SFP+ and network status:
A RX+TX
or
B RX+TX
Orange No SFP
Green steady
Green No link
slow blink
Green fast blink

A RX
or
B RX

A RX+TX
and
B RX+TX

-

No SFP

SPAN mode,
In-line mode,
link established link established
-

No link

SPAN mode,
link activity

In-line mode,
link activity
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ProfiShark Manager and Driver Installation
Windows

The ProfiShark Manager and ProfiShark drivers for Windows
are available for Windows 7, 8, and 10, 32/64 bits. They are
combined in the same package.
To install the ProfiShark Manager and Drivers, execute the
setup utility located in the “Windows” folder of the USB flash
drive. Please make sure any previous version of the ProfiShark
Manager has been uninstalled before starting the setup utility.
The setup utility will create a launch icon in your Start menu.
The ProfiShark drivers should install when a ProfiShark unit
is connected to the computer, during or after the ProfiShark
Manager installation.
For a manual installation, the drivers can be found in the
default installation folder:
C:\Program Files (x86)\Profitap\ProfiShark Manager\Driver\PT3
If the ProfiShark unit doesn’t appear in the list of network
devices, the list may be refreshed using the following
command lines in a cmd.exe window:
- net stop npf
- net start npf
The latest software releases can be found in the Profitap
Resource Center, at:
http://www.profitap.com/resource-center/

Linux

To install the ProfiShark Manager and Drivers on Linux, follow
the instructions in the Installation.txt file located on the USB
flash drive.
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Analyzer Installation
Any of the compatible analyzers can be used to perform the
analysis. Compatible analyzers are listed on the ProfiShark 10G
product page at: www.profitap.com/profishark-10g
Wireshark is recommended and can be downloaded at:
www.wireshark.org
To start capturing network data, launch your preferred network
analyzer and select the ProfiShark network interface. Refer to
your analyzer’s user manual to learn more about how to select
a network interface.

ProfiShark Manager
ProfiShark Manager is an application developed by Profitap,
designed for use in parallel with traffic analyzers (Wireshark,
ClearSight, …).
ProfiShark Manager adapts its interface to the connected
ProfiShark unit model. If multiple ProfiShark units are
connected, ProfiShark Manager adapts to the unit whose MAC
address is selected at the top right corner of the ProfiShark
Manager window.
The ProfiShark 10G version provides:
- configurable counters for real-time statistical network
analysis
- real-time SFP module and fiber optic status information
- SPAN mode/in-line mode option
- hardware filters and deep packet inspection
- capture options such as packet slicing (128 bytes), high
resolution timestamps (8 ns), CRC error transmission, and
CRC32 preservation
- ProfiShark unit information and firmware flashing utility
- Direct capture to disk function
ProfiShark Manager can be used simultaneously with a
software network analyzer, without the need to interrupt data
capture.
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ProfiShark 10G Manager
Counters — Traffic statistics
The Counters tab contains configurable counters for statistical
network traffic analysis and diagnostics.

When the checkbox is set to indeterminate (blue square),
the Counter will ignore that characteristic of the frame. In
the example below, every checkbox has been set to ignore,
meaning that the Counter will count every single packet
traversing the ProfiShark.
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When a checkbox is cleared, the corresponding characteristic
will be filtered out. In the example below, the Counter counts
will exclude Broadcast and Multicast packets.

When a checkbox is populated, the Counter will only count
frames that match this specific characteristic. In the example
below, only frames destined for or sourced from the IPv4
address 224.0.0.102 will be counted.
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Once configured, the Counters display both Packet (or Byte)
counts along with sparklines, both updated in real-time.
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SFP Modules — Port diagnostic and control
The SFP Modules tab provides real-time information about the
connected SFP modules and optical fiber.
The Ports Control section allows the switching between SPAN
mode and in-line mode. In SPAN mode, traffic is only received,
on either or both ports. In in-line mode, traffic is transmitted
between both ports. A loopback option is also available.
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Filters — Hardware filters and DPI
The Filters tab gives access to the ProfiShark’s hardware filters
and deep packet inspection feature. When enabled, only the
packets matching the filters and DPI will appear in Live Capture
and Direct Capture.

Features — Capture options and unit information
The Features tab regroups information about the driver and
firmware version, port status, the firmware update utility, and a
way to enable or disable certain ProfiShark 10G features.
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ProfiShark 10G Connected:
Lists the model of ProfiShark and its state: Connected,
Disconnected, or Upgrading Firmware.
Driver Version:
The version of driver software currently communicating with
the ProfiShark.
SW Version:
The version of ProfiShark Manager currently running.
HW Firmware Version:
The version of ProfiShark firmware currently loaded into the
ProfiShark device.
MAC Address:
A unique identifer burned into the ProfiShark device.
SFP+ Transceiver:
Declares the status of the (2) SFP+ ports, reporting whether a
transceiver is Present or Not Present.
Software Dropped Packets:
This counter increments when ProfiShark Manager realizes
that it is dropping frames due to insufficient resources,
typically CPU or disk write performance on the hosting PC.
Hardware Dropped Packets:
This counter increments when ProfiShark Manager realizes
that the ProfiShark device is dropping frames. Hardware
filtering and packet slicing can be used to prevent this.
Link Up Duration:
The time which has elapsed since the ProfiShark device saw
the Link signal go up.
Link Down Duration:
The time which has elapsed since the ProfiShark device saw
the Link signal go down.
NOTE Only one of Link Up Duration or Link Down Duration will
report a value.
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To update the ProfiShark 10G firmware, press the Browse
button, select the appropriate firmware file and press the Flash
Firmware button.
The corresponding firmware update will begin. The ProfiShark
Manager cannot be used while the update is in progress. The
update process can take a few minutes to complete. Unplug
and replug the ProfiShark device, or use the Reset button
on this screen, to use the new firmware. Do not disconnect
the USB port or shut your computer down during the update
process.
The latest firmware can be downloaded from the Resource
Center at:
www.profitap.com
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The following features can be turned on or off:
Enable timestamps in live capture:
If checked, a Unix formatted timestamp is adjoined in the
header of the packet data. This timestamp can be interpreted
by the Profitap Wireshark dissector in live capture mode.
Unix timestamp format: the 64-bit timestamp is organized in
two 32-bit words, representing the seconds since 01/01/1970,
and the fraction of second.
Transmit CRC Errors:
If checked, the ProfiShark will not filter out network packets
with CRC errors like a normal NIC would.
Keep CRC32:
Keep the CRC32 information (32-bit Frame Check Sequence)
located at the end of the packets. FCS can be interpreted in
Wireshark (Edit -> Preferences -> Protocols -> Ethernet ->
Assume packets have FCS).
Disable Port A:
If checked, the frames which input on port A are not captured.
Disable Port B:
If checked, the frames which input on port B are not captured.
Packet Slicing:
If checked, the first 128 bytes of each frame are captured.
NOTE If the Packet Slicing feature is enabled, the hardware
automatically disables the Keep CRC32 feature. No padding is
added to frames smaller than 128 bytes.
NOTE If both Transmit CRC Errors and Keep CRC32 are enabled,
all erroneous packets will be treated as correct ones.
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Capture — Direct Capture to disk
ProfiShark 10G provides the option to capture traffic without
the need for third-party capture software. This mode of capture
is performed on a driver level, prior to all network stacks and
frame processing. With the support of Direct Capture, small
packet capture can be performed at wire speed.

The capture file is saved in PCAP Next Generation format
(.pcapng).
The packet timestamps are hardware generated with 8
nanosecond accuracy. The Direct Capture feature is compatible
with the different hardware features: Packet Slicing, Transmit
CRC errors, Keep CRC32, Disable Port (see the Features
chapter).
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Direct Capture Setup
Output Capture File
Specify the name and location of the capture file. Name
extension will be added to the specified name
(_#####_YYYYMMDDHHMMSS).
Maximum Capture File Size (MB)
The capture will stop when the file reaches the specified size
in MB.
Loop
If selected, the capture does not stop. The files are erased
to keep the specified amount of capture files. A round-robin
capture can be done, with one or more files.
Number of files to use
Specify the number of capture files to be created.
Buffer size
The slider specifies the maximum volume of disk space to
consume writing capture files.
Stop when buffer is full
Checking this box terminates the capture once the buffer is
full, regardless of whether the Loop box is checked.
Start Capture
When capture is not running, starts the capture with the
specified parameters.
Stop Capture
When capture is running, stops the capture and releases the
capture file.
Written to File
Indicates the volume of data written in the Output Capture File.
Current Cache Usage
Indicates the RAM cache’s current usage.
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Dropped
Indicates the volume of data dropped during the capture.
NOTE The volume of dropped data depends on the data
storage throughput and the size of RAM cache. Disk arrays or
SSDs can dramatically improve capture performance.
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Packet Capture
ProfiShark 10G has the ability to capture:
- Any type of frames (VLAN, VXLAN, MPLS, Pause frames, etc.)
- Any encapsulated frames
- CRC errors frames
- Short frames (< 64 bytes)
- Jumbo frames (> 1518 bytes)
- Any frames between 10 bytes and 10 Kbytes
Once the drivers have been installed, a new connection is
added in the Network Connection panel. ProfiShark 10G acts
as a 20 Gbit/s unidirectional NIC, regardless of the network
connection speed. Frame aggregation is done in the ProfiShark
hardware and respects the original frame order. As opposed to
FIFO (First In, First Out), the ProfiShark 10G employs an FCFS
(First Come, First Served) mechanism.
A reboot of the computer may be required to refresh the
Winpcap/Wireshark device list. ProfiShark 10G has been tested
with all major capture/analyzer software.
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Live Capture vs Direct Capture
Two mode of capture are available: Live Capture mode, and
Direct Capture mode.
In Live Capture mode, the capture is performed like on any
other network card. The frames are routed to the NDIS driver.
In Direct Capture mode, the frame stream is dumped to the
disk. The capture file format is computed in the ProfiShark
hardware.

ProfiShark Hardware, 8ns Timestamp
Direct Capture Format Computation

ProfiShark NIC
Capture Driver

ProfiShark Direct
Capture Driver

Network Driver
(NDIS)

HDD/SSD

Capture Driver
(e.g. Winpcap)

Protocol Analyzer
(e.g. Wireshark)
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Live Capture Mode
ProfiShark 10G transmits network frames to the capture
software without altering them. It is transparent for packet
size, packet type, or protocols. All tags and encapsulation are
preserved (e.g. VLAN, MPLS, GRE).

The Software Dropped Packets counter in the Features tab
indicates the number of packets dropped by the driver in Live
Capture mode. It is not representative of the packets dropped
in Direct Capture (see the Direct Capture Mode chapter). These
drop events are caused by high CPU usage.
The Hardware Dropped Packets counter indicates the volume
of captured packets dropped due to a high demand for USB
bandwidth. Hardware filters and packet slicing can greatly
reduce the amount of traffic to be captured and thus mitigate
hardware packet drops.
NOTE Capture of small packet at high speed is extremely
challenging for processors and can cause software drops. For
that reason, another capture mode is available (see the Direct
Capture Mode chapter).
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Timestamping
The hardware timestamping feature can be used in both Live
Capture and Direct Capture mode. The ProfiShark dissector for
Wireshark must be installed in order to interpret ProfiShark
timestamps. The dissector files can be found on the provided
USB flash drive, or in the Resource Center at: profitap.com
The dissector is compatible with Wireshark (x86 and x64)
1.12.x, 2.0.x, and 2.2.x.
Linux: Copy the file (profishark.so) to ‘/usr/local/lib/wireshark/
plugins/[wireshark_version]/’, from x86 or x64 depending on
the Linux version.
Windows:
Copy the file (profishark.dll) in the ‘plugins/[wireshark_
version]/’ subfolder of your Wireshark installation folder, from
x86 or x64 depending on the Windows version. Note that each
time you upgrade to a new version of Wireshark, you must
repeat this step.
The dissector can be enabled or disabled in the Wireshark
preferences (Edit -> Preferences -> Protocols -> ProfiShark ->
Decode timestamps for ProfiShark 10G).
The timestamp option must be enabled in the ProfiShark
Manager’s Features tab (see the Features chapter).

If Decode timestamps for ProfiShark 10G is enabled, Wireshark
assumes that every packet contains the ProfiShark timestamp.
If timestamps are not displayed in nanosecond resolution in
Wireshark, select Nanoseconds in View -> Time Display Format.
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Additional information
Ordering reference
C1AP-10G
Connectors
2 x SFP+
1 x USB 3.0
1 x 5 VDC optional input
LEDs
4 x Link activity
1 x Power
System requirements
Dual Core Processor
4 GB memory
USB 3.0 port
Supported OS
Windows 10 (32- and 64-bit)
Windows 8 (32- and 64-bit)
Windows 7 (32- and 64-bit)
Linux

24

Dimensions (WxDxH)
105 x 124 x 26 mm
4.13 x 4.88 x 1.02 in
Weight
280 g / 0.62 lb
Operating temperature
0 to +50°C / 32 to 122°F
Storage temperature
-40 to +80°C / -40 to 176°F
Relative humidity
10 to 95%, non-condensing
Accessories
1.8m USB 3.0 cable
USB key
Compliance
RoHS

Disclaimer
The information in this document is subject to change without
notice. The manufacturer makes no representations or
warranties with respect to the contents hereof and specifically
disclaims any implied warranties of merchantability or fitness
for any particular purpose. The manufacturer reserves the
right to revise this publication and to make changes in the
content hereof without obligation of the manufacturer to notify
any person of such revision or changes.
Warranty and Liability
Profitap warrants that this product is free from defects in
material and workmanship at time of shipment. The warranty
period is two years from the date of purchase. Profitap
assumes no liability for products that have been subjected to
abuse, modification, misuse, or if the model or serial number
has been altered, tampered with, defaced or removed. Profitap
is not liable under any contract, negligence, strict liability
or other legal or equitable theory for any loss of use of the
product, inconvenience or damages of any character, whether
direct, special, incidental or consequential (including, but not
limited to, damages for loss of goodwill, loss of revenue or
profit, work stoppage or malfunction).
Copyright
This publication, including all photographs and illustrations
is protected under international copyright laws with all
rights reserved. Neither this manual, nor any of the material
contained herein, may be reproduced without written consent
of the author.
Trademarks
The trademarks mentioned in this manual are the sole
property of their owners.
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CUSTOMER SUPPORT INFORMATION
To order or for technical information support:
Telephone
+31 (0) 40 782 0880
Mail order
Profitap HQ B.V.
High Tech Campus 9
5656 AE Eindhoven
The Netherlands
E-mail
info@profitap.com
Website
www.profitap.com

©2018 PROFITAP — v1.0.7
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